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TUYÊN BỐ BẢN QUYỀN

Tài liệu này thuộc loại sách giáo trình nên các nguồn thông tin có thể được phép dùng

nguyên bản hoặc trích dùng cho các mục đích về đào tạo và tham khảo.

Mọi mục đích khác mang tính lệch lạc hoặc sử dụng với mục đích kinh doanh thiếu

lành mạnh sẽ bị nghiêm cấm.

LỜI GIỚI THIỆU

Việt Nam chính thức gia nhập Internet vào tháng 12/1997, nhưng mãi đến những

năm gần đây ta mới thấy sự hiện diện rõ ràng của Internet trong cuộn sống thể hiện qua

hàng loạt điểm truy cập Internet mọc lên khắp nơi, từ Hà Nội, Huế, Đà Nẵng, Cần Thơ,

Thành Phố Hồ Chí Minh, và đặc biệt trong các hộ gia đình. Tuy nhiên vẫn còn nhiều bất

cập. Nhưng đó là một dấu hiệu đáng mừng vì chúng ta đang bắt đầu hòa nhập vào mạch

sống tri thức, hiện đại của thế giới.

Hiện tại không thể thống kê nổi số lượng máy tính kết nối với Internet, Internet

cũng đã đến với tàu thuyền ngoài khơi, máy bay, xe cộ. Các công ty tư nhân cung cấp các

truy cập dịch vụ Internet qua đường truyền điện thoại, các cổng USB … và bất kỳ tư gia

hay văn phòng nào đều có dễ dàng hòa mạng Internet, với cước thuê bao truy cập ngày

càng giảm

Có thể Internet sẽ không tác động đến bạn hiện giờ như trong tương lai không sớm

hay muộn thì điều đó nhất định sẽ xẩy ra.

Cuốn sách này sẽ hướng dẫn các bạn sử dụng trình duyệt internet, tạo mail, blog

và cách tìm kiếm thông tin trên internet

TPHCM, ngày 05 tháng 09 năm 2024
Tham gia biên soạn

Chủ biên
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GIÁO TRÌNH MÔN HỌC/MÔ ĐUN 

Tên mô đun: INTERNET 

Mã số mô đun: MĐ 10 

Thời gian mô đun: 30 giờ;        (Lý thuyết: 15 giờ; Thực hành: 13 giờ, kiểm tra: 2) 

Vị trí, tính chất, ý nghĩa và vai trò của môn học/mô đun: 

- Vị trí:  

+ Mô đun học được bố trí sau khi học sinh học xong các mô đun, môn học chung và 

trước các môn học, mô đun đào tạo chuyên môn nghề quản trị CSDL.  

- Tính chất:  

+ Là mô đun cơ sở bắt buộc hỗ trợ cho HSSV các kỹ năng về khai thác thông tin 

trên Internet 

Mục tiêu của môn học/mô đun: 

- Về mặt kiến thức:  

+ Nắm rõ được bản chất và tầm quan trọng của Internet và  world wide web 

+ Trình bày các thành phần của một website 

+ Trình bày các nguyên lý làm việc của chương trình quản lý email và web mail.  

- Về mặt kỹ năng:  

+ Thao tác được chương trình thư điện tử và sử dụng được toàn bộ các phương tiện 

sẵn có để sử dụng Internet  

+ Cấu hình và tạo được kết nối với  Internet qua điện thoại, các nối kết mạng.  

+ Sử dụng các công cụ để tìm kiếm có hiệu quả các thông tin trên world wide web.  

- Về mặt năng lực tự chủ và trách nhiệm: 

 + Nghiêm túc và thực hiện đúng các qui chế về việc sử dụng Internet 

+ Hoàn thiện tốt các yêu cầu được giao trong việc tìm kiếm các thông tin 

Nội dung của môn học/mô đun: 
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Bài 1: TẠO KẾT NỐI INTERNET 

Giới thiệu 

Internet là một hệ thống thông tin toàn cầu có thể được truy nhập công cộng gồm 

các mạng máy tính được liên kết với nhau. Hệ thống này truyền thông tin theo kiểu nối 

chuyển gói dữ liệu (packet switching) dựa trên một giao thức liên mạng đã được chuẩn hóa  

gọi là giao thức IP. 

Mục tiêu của bài 

- Hiểu được khái niệm về Internet  

- Trình bày được các dịch vụ trên internet 

- Tầm quan trọng của Internet 

Nội dung bài  

1. Cấu hình kết nối Internet 

2. Kết nối mạng Internet với ADSL 

3. Xử lý các sự cố thông dụng 

Nội dung chi tiết 

1. Cấu hình kết nối Internet 

- Internet là một tập hợp của các máy tính được nối với nhau và chủ yếu là qua đường 

điện thoại trên toàn thế giới với mục đích trao đổi và chia sẻ thông tin.  

- Internet do Bộ Quốc Phòng Mỹ phát minh năm 1969 với mục đích hỗ trợ truyền thông 

trong trường hợp bị tấn công hạt nhân 

- Trước đây mạng Internet được sử dụng chủ yếu ở các tổ chức chính phủ và trong các 

trường học. Ngày nay mạng Internet đã được sử dụng bởi hàng tỷ người bao gồm cả cá 

nhân các doanh nghiệp lớn, nhỏ, các trường học. Phần chủ yếu nhất của mạng Internet là 

World Wide Web. 

- Mạng Internet là của chung điều đó có nghĩa là không ai thực sự sở hữu nó với tư 

cách cá nhân. Mỗi phần nhỏ của mạng được quản lý bởi các tổ chức khác nhau nhưng 

không ai không một thực thể nào cũng như không một trung tâm máy tính nào nắm quyền 

điều khiển mạng. Mỗi phần của mạng được liên kết với nhau theo một cách thức nhằm 

tạo nên một mạng toàn cầu. 

- Các khái niệm cơ bản: 

a)  HTML (HyperText Markup Language): Ngôn ngữ đánh dấu siêu văn bản 

dùng để tạo nên các văn bản liên kết. 

b) HTTP (HyperText Tranport Protocol): Là giao thức được dùng để truyền các 

siêu văn bản trên internet. 

c) Web page: Là một tài liệu HTML, trong đó lưu các nội dung và định dạng 

văn bản, hình ảnh, … theo định dạng HTML. 

d) Web site: Là một tập hợp các trang Web liên kết với nhau và được quản lý 

bởi cá nhân hay một tổ chức nào đó. 

e) Home page: Là trang Web đầu tiên của một Website. Homepage chính là bộ 

mặc của một Website. 
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f) Giao thức TCP/IP: (Tranmission Control Protocol/Internet Protocol): Là tập 

hợp các giao thức dùng để truyền tải và sửa lỗi dữ liệu, nó cho phép truyền dữ liệu từ 

máy tính này sang máy tính khác trên mạng Internet. 

g) Địa chỉ IP: (IP Address): Mỗi máy tính trên mạng được gắn một địa chỉ riêng 

biệt gọi  là địa chỉ IP, nó tốn tại duy nhất trong mạng. Một địa chỉ IP được chia thành 

4 nhóm, các nhóm được cách nhau dấu chấm, mỗi nhóm gồm 3 chữ số có giá trị từ 

000 đến 255., ví dụ: 112.78.14.20 

h) Tên miền (Domain Name):Vì địa chỉ IP là những dãy số rất khó nhớ, do đó 

người ta dùng tên miền để thay thế địa chỉ IP, ví dụ: www.trungcapnghecuchi.edu.vn 

i) User: Người sử dụng ( có thể là trường học, công ty hay một cá nhân). 

j) ICP (Internet Content Provider): Nhà cung cấp thông tin lên Internet. 

k) ISP (Internet Service Provider): Nhà cung cấp dịch Internet. 

l) IAP ( Internet Access Provider): Nhà cung cấp cổng truy cập vào Internet 

cho các mạng. 

2. Kết nối Internet với ADSL 

URL: Uniform Resoure Locator: Là toàn bộ địa chỉ của Web site hoặc trang Web. 

Mỗi URL có ít nhất  

Ví  dụ URL: http://www.ddcpub.com 

+ Phần 1 : http : là giao thức truyền thông dùng để truy cập Web site (hai dấu gạch 

xiên là mã mãng)  

+ Phần 2: là tên không trùng lắp của Web site gọi là tên vùng hoặc tên miền (domain 

name)  

+ Phần tên vùng theo sau có dấu chấm cuối 

Ví dụ:  .com  ➔ gọi là tên vung cấp cao nhất ( chỉ tổ chức xuất bản Web )  

 

Vùng Loại 

.com 

.gov 

.edu 

.org 

.mil 

.net 

commercial/business (thương mại/kinh doanh) 

government (chính phủ) 

educaltional (giáo dục) 

various organization (các tổ thức thuộc đủ loại) 

military (quân sự) 

network resoures (tài nguyên mạng) 

 

Phần tên vùng đứng trước dấu chấm cuối gọi tên vùng cấp hai, định dạng thực thể 

sở hữu trang Web đó  

 Ví dụ : http://www.ddcpub.com 

- Một số  URL còn có thêm phần thứ ba – đường dẫn đến một trang Web trong 

phạm vi Website . Ở URL  

 Ví dụ: http://www.ddcpud.com/learn  

Dấu  /  theo sau tên vùng chịu trách nhiệm phân cách tên thư mục và tên tập tin trên máy 

tính của Website 
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1. Xử lý sự cố thông dụng 

Trong quá trình sử dụng Internet sẽ không tránh khỏi một sự cố và bối rối khi không 

biết đâu là nguyên nhân gây ra các sự cố và cách pháp khắc phục như thế nào. Dưới đây là 

một số lỗi thường gặp nhất, nguyên nhân và giải pháp cho từng sự cố. 

3.1. Không thể lấy địa chỉ IP 

Dấu hiệu: 

Biểu tượng mạng trên máy tính hiển thị tình trạng không hoạt động. Hệ điều hành 

cảnh báo không thể nhận địa chỉ IP từ máy chủ DHCP. Khi kiểm tra trạng thái cổng mạng, 

không có địa chỉ nào được gán ngoại trừ địa chỉ 169.254.x.x (là địa chỉ hệ điều hành 

Windows tự cấp cho máy tính khi không nhận được IP). 

Nguyên nhân: 

Có thể do máy chủ DHCP hết quỹ địa chỉ, dịch vụ DHCP trên máy chủ bị vô hiệu 

hóa, hoặc yêu cầu DHCP được gửi từ thiết bị đầu cuối không đến được máy chủ. 

Giải pháp: 

Hãy lưu ý xem “Lỗi này chỉ xảy ra với một người dùng hay với tất cả mọi người?” 

Nếu chỉ một người bị lỗi, nên kiểm tra lại cấu hình DHCP trên máy trạm. Sau đó, kiểm tra 

cổng mạng tương ứng thuộc VLAN nào trên switch. Kiểm tra máy trạm của người dùng 

trên VLAN tương ứng có thể nhận địa chỉ IP hay không. Nếu chúng không nhận được, sự 

cố này có thể do router không thể chuyển tiếp các yêu cầu DHCP đến máy chủ. Nếu các 

máy trạm thuộc nhiều VLAN khác nhau cùng bị lỗi, nguyên nhân sẽ do chính máy chủ 

DHCP. Máy chủ có thể chưa chạy dịch vụ DHCP, hoặc đã cạn quỹ địa chỉ. Nếu tổ chức có 

nhiều máy chủ DHCP, lỗi này có thể do một trong số các máy chủ được cấu hình không 

phù hợp. Ngoài ra, cũng có thể do một AP (Access Point) giả mạo, do nhân viên tự ý mang 

đến và cắm vào hệ thống mạng, cung cấp dịch vụ DHCP giả mạo cho hệ thống mạng. 

3.2. Không thể kết nối đến máy chủ 

Dấu hiệu: 

Ứng dụng trên máy người dùng cảnh báo “Không thể kết nối đến máy chủ”. Các 

cảnh báo này xuất hiện khi người dùng sử dụng các ứng dụng như e-mail, CRM. Người 

dùng hay than phiền do mạng bị “rớt”, tuy nhiên đó không phải là nguyên nhân duy nhất 

của vấn đề. 

Nguyên nhân: 

Lỗi này có thể xảy ra do nhiều nguyên nhân khác nhau. Điều cần quan tâm là có gặp 

lỗi thường xuyên không, hay chỉ thỉnh thoảng? Nếu lỗi xảy ra thường xuyên dù máy tính 

đã được cấp địa chỉ IP phù hợp, nguyên nhân có thể do các vấn đề về định tuyến trên hệ 

thống mạng giữa máy trạm và máy chủ, có thể kiểm tra dễ dàng với một vài thao tác “ping”. 

Nếu lỗi xảy ra không thường xuyên, có thể do máy chủ bị quá tải và không thể phản hồi 

các yêu cầu từ máy trạm. 

Giải pháp: 

Trong trường hợp không phải do định tuyến, hãy kiểm tra lại mức độ sử dụng và tài 

nguyên của máy chủ. Máy chủ có đang quá tải do chạy song song các tác vụ khác như sao 

lưu dữ liệu không? Nếu không, thử kiểm tra lưu lượng mạng giữa máy trạm và máy chủ 

xem có quá tải không? Phương thức tốt nhất là sử dụng công cụ SNMP nhằm giám sát hiệu 
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năng các kết nối. Ngoài ra, các lỗi Ethernet (FCS Error, Alignment Error, hay Late 

Collision) trên switch và router cũng có thể là nguyên nhân gây mất gói tin giữa máy trạm 

và máy chủ. 

3.3. Hiệu suất ứng dụng thấp 

Dấu hiệu: 

Các ứng dụng hoạt động chậm chạp. Màn hình của người dùng có thể bị đứng, 

không hoạt động hoặc bị ngăn chặn khi truy xuất dữ liệu. Thông thường, người dùng sẽ đổ 

lỗi cho hệ thống mạng hoạt động quá chậm. 

Nguyên nhân: 

Để tránh đổ lỗi cho hệ thống mạng, các nhân viên IT phải chẩn đoán, cô lập và xác 

định chính xác vùng xảy ra sự cố. Việc ứng dụng hoạt động không tốt có thể xuất phát từ 

nhiều nguyên nhân, thường gặp nhất là do máy chủ tiến hành sao lưu dữ liệu trong giờ làm 

việc, chiếm tài nguyên hệ thống mạng, làm giảm tốc độ truy suất cơ sở dữ liệu của máy 

chủ và gây mất gói trên hệ thống mạng. Ở góc độ kỹ thuật viên, cần xác định nguyên nhân 

sự cố là do máy chủ hay do hệ thống mạng? Để làm được điều đó, cần thu thập các gói tin 

của ứng dụng và tìm xem có hoạt động truyền lại nào giữa máy trạm và máy chủ không? 

Nếu có, đồng nghĩa việc mất gói tin trên đường truyền chính là nguyên nhân ảnh hưởng 

đến hiệu suất ứng dụng. Nếu không xuất hiện tình trạng truyền lại, kết nối giữa máy trạm 

và máy chủ vẫn được thiết lập bình thường, nguyên nhân có thể liên quan đến các vấn đề 

tại máy chủ. 

Giải pháp: 

Dù rất khó tìm ra nguyên nhân vấn đề nếu chỉ dựa vào bộ phân tích gói tin, nhưng 

người ta vẫn thường dùng chúng để đếm số lượt truyền lại các gói TCP. Sử dụng bộ đếm 

này giúp xác định số gói tin bị mất giữa máy trạm và máy chủ. Tham khảo các thông số 

như lỗi Ethernet trên switch, router giữa máy trạm và máy chủ có thể là nguyên nhân gây 

ra hiện tượng mất gói tin. Nếu không xuất hiện các lỗi trên, hãy lưu ý khả năng mất gói tin 

trên hệ thống WAN do sử dụng vượt mức cho phép của nhà cung cấp dịch vụ. Ngoài ra, 

cũng có thể đo lường hiệu suất ứng dụng bằng các bộ công cụ phân tích mạng chuyên 

nghiệp, cung cấp thông tin từ việc bắt các gói tin và phân tích thời gian phản hồi từ các 

máy chủ, thời gian xử lý trên máy con và cả thời gian truyền trên hệ thống mạng, từ đó đưa 

ra nhận định chính xác đâu là nguyên nhân gây ra lỗi hiệu suất mạng. 

3.4. Các lỗi về in ấn 

Dấu hiệu: 

Hệ thống in ấn qua mạng hoạt động không ổn định. Máy in vẫn hiển thị sẵn sàng 

nhưng các tác vụ in được gửi lại không thể hoàn thành. 

Nguyên nhân: 

Cần xác định tình trạng này xảy ra tại một hay nhiều máy trạm? Nếu chỉ xảy ra tại 

một máy, có thể do máy tính không được thiết lập phù hợp để kết nối đến máy in. Nếu 

không phải nguyên nhân này, có thể do hệ thống mạng giữa máy trạm và máy in gặp vấn 

đề. Mất gói tin cũng có thể là nguyên nhân gây ra các lỗi về kết nối mạng của máy in.. 

Giải pháp: 
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Kiểm tra cấu hình máy trạm xem đã nhận được địa chỉ IP thích hợp để truy cập đến 

máy in chủ (print server) chưa? Đôi khi, cập nhật trình điều khiển máy in (driver) cũng 

giúp giải quyết các lỗi này. Nhìn chung, hãy chắc chắn dung lượng mạng đến và đi từ máy 

in luôn được đảm bảo, đồng thời cập nhật các trình điều khiển cho tất cả các máy in trong 

hệ thống. 

3.5. Cáp kém chất lượng 

Dấu hiệu: 

Chất lượng kết nối của máy trạm rất thấp, thậm chí không thể kết nối vào bất kì thiết 

bị nào trong hệ thống mạng. 

Nguyên nhân: 

Gigabit cho máy trạm đã trở nên thông dụng trong hệ thống mạng hiện nay. Công 

nghệ Gigabit cần bốn đôi dây cho một kết nối, do đó, hệ thống cáp phải đạt tiêu chuẩn từ 

Cat. 5e trở lên. Với các tòa nhà cũ, đây là nguyên nhân cần lưu ý đầu tiên. Ngoài ra, cáp bị 

tháo xoắn quá nhiều (khi bấm đầu hay kết nối vào thanh đấu nối) cũng có thể là nguyên 

nhân gây mất tín hiệu, dẫn đến lỗi FCS trên switch hay tại cổng mạng máy tính. 

Giải pháp: 

Trong hầu hết trường hợp, giải pháp đơn giản nhất là thay thế cáp. Nếu lỗi là do 

tháo xoắn cáp quá mức, tiến hành bấm lại đầu kết nối và kiểm tra bằng bộ máy test cáp 

mạng LAN sẽ giải quyết được vấn đề. Nếu do hệ thống cáp đã lỗi thời, không thể hỗ trợ 

các công nghệ mới như Gigabit hay PoE (Power over Ethernet), nên cân nhắc việc thay thế 

bằng hệ thống cáp Cat. 5e hoặc hơn. 

3.6. Lỗi DNS 

Dấu hiệu: 

Người dùng không thể kết nối Internet hoặc các ứng dụng. Hệ thống mạng hiển thị 

không kết nối. 

Nguyên nhân: 

Máy trạm không thể phân giải tên của máy chủ nên không thể gửi các yêu cầu kết 

nối. Nguyên nhân thường do cấu hình DNS trên máy trạm không phù hợp, máy chủ không 

thể phân giải được các yêu cầu DNS gửi từ máy trạm (do không có trong cơ sở dữ liệu), 

hay do mất gói tin trên đường truyền. Do DNS là một loại giao thức UDP nên các gói tin 

bị mất không được truyền lại. Đây là nguyên nhân cơ bản dẫn đến lỗi DNS. 

Giải pháp: 

Kiểm tra lại cấu hình DNS máy trạm. Nếu cấu hình không chính xác, cần cấu hình 

lại cho máy trạm hoặc cấu hình lại máy chủ DHCP nhằm cung cấp thông tin chính xác cho 

máy trạm. Kiểm tra máy chủ DNS từ phía máy trạm nhiều lần nhằm đánh giá tình trạng 

phản hồi của máy chủ, xem có xuất hiện tình trạng mất gói không? Nếu có, hãy xem xét 

các lỗi Ethernet giữa máy trạm và máy chủ. Tốt nhất, nên thiết lập một công cụ liên tục 

kiểm tra máy chủ DNS và cảnh báo khi có sự cố xảy ra. 

3.7. Máy trạm không thể kết nối Wi-Fi 

Dấu hiệu: 

Máy trạm có thể phát hiện AP nhưng không thể kết nối vào hệ thống Wi-Fi. 

Nguyên nhân: 

http://maytestcap.com/microscanner2-bo-may-test-cap-mang-lan-danh-cho-it-10-m8.a.html
http://maytestcap.com/microscanner2-bo-may-test-cap-mang-lan-danh-cho-it-10-m8.a.html
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Không có thông tin về bảo mật, nhiễu kênh và điểm chết có thể là nguyên nhân của 

vấn đề. Vì hệ thống mạng không dây là vô hình, rất khó để theo dõi các sự cố trừ khi có 

công cụ thích hợp. 

Giải pháp: 

Sử dụng các công cụ giám sát mạng không dây để đo lường độ mạnh tín hiệu tại 

vùng ảnh hưởng, và nếu có thể, hãy khảo sát các vùng lân cận, tìm kiếm các AP không 

chính thức hay AP mạo danh-là các AP mà người dùng mang vào sử dụng mà chưa có sự 

cho phép từ các kỹ sư quản trị mạng. Các AP này có thể được cấu hình chồng lên các kênh 

Wi-Fi hiện có và ảnh hưởng đến chất lượng Wi-Fi. Kiểm tra các nguồn nhiễu xung quanh 

các AP như lò vi sóng hay điện thoại không dây. Kiểm tra tiến trình kết nối đến AP của 

máy trạm, xác định lỗi xuất hiện ở bước nào– Liên kết, xác thực, chứng thực, ủy quyền. 
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Câu hỏi ôn tập 

TRẮC NGHIỆM 

Câu 1: “Internet” là gì? 

A. Hệ thống máy tính  

B. Hệ thống mạng máy tính  

C. Hệ thống mạng máy tính trong một nước  

D. Hệ thống mạng máy tính toàn cầu  

Câu 2: “Online” có nghĩa là gì  

A. Đang tải  

B. Không tải  

C. Trực tuyến  

D. Không trực tuyến  

Câu 3: “offine” là gì?   

A. Đang tải  

B. Không tải  

C. Trực tuyến  

D. Không trực tuyến  

Câu 4: “download” có nghĩa là gì?  

A. Đang tải  

B. Không tải  

C. Trực tuyến  

D. Tải file hay folder  

Câu 5: nút “home”    trên web có nghĩa là gì  

A. Quay về trang chủ  

B. Quay về trang trước  

C. Quay lên phía trên  

D. Quay xuống phía dưới  

Câu 6:“www” TRÊN ĐỊA CHỈ TRANG WEB LÀ GÌ  

A. Word Web Wide 

B. World Wide Web 

C. Word Web Wide 

D. World  

Câu 7: “www.edu.vn” , “vn” trên địa chỉ trang web có nghĩa là gì?  

A. Một ký hiệu nào đó  

B. Ký hiệu tên nước việt nam  

C. Chữ viết tắc tiếng Anh  

D. Chữ viết tắc của chữ Việt Nam 

Câu 8: www.microsoft.com . “com” có nghĩa là  

A. Đây là địa chỉ của các trang Web thương mại, dịch vụ  

B. Đây là địa chỉ trang web giáo dục  

C. Đây là địa chỉ của các trang web giải trí  

D. Đây là địa chỉ của các Trang Web thông thường  

http://www.microsoft.com/
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Câu 9: ISP là viết tắt của?  

A. Internet Service Provider 

B. Internet Server Provider  

C. Câu A,B đúng  

D. Câu A,B sai  

Câu 10: IAP là từ viết tắt của ?  

A. Internet Application Provider 

B. Internet Access Provider 

C. Câu A, B đúng  

D. Câu A, B sai  

Câu 11: Việt Nam chính thức gia nhập internet vào ngày tháng năm nào?  

A. 1/12/1997 

B. 12/08/1997 

C. 20/07/1997 

D. 30/07/1997 

Câu 12: IRC là từ viết tắc của  

A. Internet Ready Chat 

B. Internet Relay Chat 

C. Câu A,B đều đúng  

D. Câu A,B đều sai  
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BÀI 2: TRUY CẬP WEBSITE - DỊCH VỤ WWW 

Giới thiệu 

Các tài liệu trên World Wide Web được lưu trữ trong một hệ thống siêu văn bản 

(hypertext), đặt tại các máy tính trong mạng Internet. Người dùng phải sử dụng một chương 

trình được gọi là trình duyệt web (web browser) để xem siêu văn bản. Chương trình này sẽ 

nhận thông tin (documents) tại ô địa chỉ (address) do người sử dụng yêu cầu (thông tin 

trong ô địa chỉ được gọi là tên miền (domain name)), rồi sau đó chương trình sẽ tự động 

gửi thông tin đến máy chủ (web server) và hiển thị trên màn hình máy tính của người xem. 

Người dùng có thể theo các liên kết siêu văn bản (hyperlink) trên mỗi trang web để nối với 

các tài liệu khác hoặc gửi thông tin phản hồi theo máy chủ trong một quá trình tương tác. 

Hoạt động truy tìm theo các siêu liên kết thường được gọi là duyệt Web. 

Quá trình này cho phép người dùng có thể lướt các trang web để lấy thông tin. Tuy 

nhiên độ chính xác và chứng thực của thông tin không được đảm bảo 

Một số trình duyệt web hiện nay gồm Internet Explorer, Mozilla Firefox, Safari, 

Opera, Avant Browser, Konqueror, Lynx, Google Chrome, Flock, Arachne, Epiphany, K-

Meleon và AOL Explorer… 

Mục tiêu của bài: 

- Hiểu được dịch vụ www trên internet  

- Cài đặt và sử dụng các trình duyệt internet thông dụng 

- Sử dụng hộp thư và lưu trữ các trang web ưu thích  

Nội dung bài  

1. Cài đặt và cấu hình trình duyệt web 

1.1. Yêu cầu hệ thống  

1.1.1. Computer/Processor Máy tính / Bộ vi xử lý  

Computer with a 233MHz processor or higher (Pentium processor recommended) Máy 

tính với một bộ xử lý 233MHz hoặc cao hơn (bộ xử lý Pentium ).  

1.1.2. Operating System Hệ điều hành  

+ Windows Server 2003 32-bit or 64-bit with SP2  

+ Windows Server 2008 32-bit or 64-bit 

Memory Bộ nhớ  

+ Windows Server 2003 32-bit with SP 2 or higher – 64MB  

+ Windows Server 2003 64-bit with SP 2 or higher – 128MB  

+ Windows Server 2008 32-bit or 64-bit  – 512MB  

Hard Drive Space Hard Drive Space  

+ Windows Server 2003 32-bit with SP 2 or higher – 150MB  

+ Windows Server 2003 64-bit with SP 2 or higher – 200MB  

+ Windows Server 2008 32-bit – 150MB  

+ Windows Server 2008 64-bit – 200MB 

Drive Drive  

+ CD-ROM CD-ROM (nếu cài đặt được thực hiện từ một đĩa CD-ROM).  

Display Hiển thị  
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+ Super VGA (800 x 600) or higher-resolution monitor with 256 colors. Super VGA 

(800 x 600) hoặc cao hơn độ phân giải màn hình với 256 màu sắc.  

Peripherals Thiết bị ngoại vi  

+ Modem or Internet connection; Microsoft Mouse, Microsoft IntelliMouse, or 

compatible pointing device. Modem hoặc kết nối Internet; Microsoft Mouse, 

Microsoft IntelliMouse, hoặc thiết bị trỏ tương thích.  

1.2. Cài đặt trình duyệt web 

1.2.1. Cài đặt Internet Explore: 

Bước 1: Download gói phần mềm Internet Explore (ví dụ: IE8-WindowsXP-x86-ENU.exe) 

Bước 2: Double lick vào IE8-WindownsXP-x86-ENU.exe 

 
Hình 2.1: Cửa sổ cài đặt Internet Explorer 

Bước 3:Khi bắt đầu cài đặt IE 8, Microsoft yêu cầu người dùng lưu file và đóng các chương 

trình đang hoạt động 

 

  
Hình 2.2: Cửa sổ cài đặt Internet Explorer 

 

1.2.2. Cài đặt Firefor 

- Một trong những chương trình duyệt Web miễn phí được đánh giá là có tốc độ duyệt 

Web và bảo mật cao đó là Firefox (FF). Ngoài các tính năng có sẵn Firefox còn có 

thể kết hợp với các thành phần mở rộng (Extension) khác hỗ trợ duyệt Web rất tốt 

cho người sử dụng. 

Bước 1:Tải Firefox tại trang Web http://www.mozilla.com/en-US/firefox/ và cài đặt 

cũng giống như các chương trình thông thường.  

Bước 2: Ở lần chạy đầu tiên chương trình sẽ đưa ra các thông báo người dùng có 

muốn đưa các thông tin như các địa chỉ, mật khẩu, cài đặt... từ trình cũ có sẵn trên máy 

(Internet Explorer, ...) vào Firefox hay không, chọn trình duyệt nào muốn Import hoặc chọn 

Don't import anything nếu không muốn và nhấn Next để tiếp tục.   

http://www.mozilla.com/en-US/firefox/
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Hình 2.3: Cửa sổ Import Wizard 

 

Bước 3: Xuất hiện bảng lựa chọn trình duyệt Web nào làm mặc định nếu trên máy có 

cài nhiều trình duyệt Web, nhấn Yes nếu muốn chọn FF hoặc No để chọn trình duyệt có 

sẵn trên máy.  

 

 

 

 

 

 

 

Hình 2.4: Cửa sổ Default Brower 

 

Các nút lệnh chính của FF: 

 
Hình 3.5: Các nút lệnh Firefox 

+ Back: Quay lại trang Web đã xem trước đó. 

+ Forward : Chuyển tới trang Web đã xem sau khi nhấn Back. 

+ Refresh: Tải lại toàn bộ trang Web hiện tại, dùng trong trường hợp trang web bị lỗi 

hiển thị hoặc muốn cập nhật lại trang Web. 

+ Stop: Ngừng tải các nội dung của trang Web đang xem. 

+ Home: Hiển thị trang Web đã được chọn làm trang chủ, nếu chưa được chọn thì sẽ 

hiển thị trang trắng.  

+ Address: Nơi nhập địa chỉ của trang Web muốn xem, có thể nhập đầy đủ 

http://www.buaxua.vn/ hay chỉ cần nhập buaxua.vn cũng được. 

+ Go: Lệnh xem trang Web có địa chỉ được nhập trong Address, nhấn vào nút Go để 

ra lệnh hoặc có thể nhấn phím Enter trên bàn phím. 

+ Search: Công cụ giúp tìm kiếm thông tin trên Internet, mặc định FF sẽ chọn Google 

làm dịch vụ tìm kiếm, nhập từ cần tìm vào trong ô Google sau đó nhấn phím Enter 

trên bàn phím hoặc nhấn vào nút có biểu tượng kính lúp ngay bên phải. 
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2. Truy cập Website 

2.1. Mở thêm một trang web khác: Thông thường khi muốn mở thêm một trang Web thì sẽ 

xuất hiện thêm một cửa sổ mới nhưng với Firefox người sử dụng có thể mở nhiều trang 

Web dưới dạng các bảng riêng (Tab) trong một cửa sổ và chuyển đổi qua lại giữa các Tab 

rất thuận tiện.  

− Nhấn phải chuột vào liên kết (Link) muốn mở và chọn Open Link in New Window  

− Nếu muốn mở trong một cửa sổ mới hoặc Open Link in New Tab để mở trong một Tab 

của cửa sổ hiện tại.  

− Có thể chọn File -> New windows hoặc New Tab để mở một cửa sổ hoặc một Tab trống 

rồi nhập địa chỉ vào ô Address. 

2.2. Mở trang Web đã lưu:  

− Chọn File -> Open File, 

− Tìm và chọn trang Web muốn mở, nhấn Open để mở. 

2.3. Tìm kiếm thông tìn trong trang Web: Để tìm một hoặc nhiều từ nào đó trong trang 

Web,  

− Chọn Edit -> Find in this Page,  

− Công cụ tìm kiếm sẽ xuất hiện ở phía dưới cửa sổ nội dung, nhập từ cần tìm vào ô 

Find và nhấn phím Enter để tìm.  

− Nhấn Next hoặc Previous để tiếp tục tìm lên trên hay xuống dưới trang Web. 

−  

− Tăng hoặc giảm kích thước chữ: Muốn tăng hoặc giảm kích thước của chữ trong 

trang web, chọn Zoom -> Zoom In: lớn hơn, Zoom Out: nhỏ hơn, Reset: trung bình. 

 

 

 

 

 

 

 

 

 

 

Hình 2.6: Tăng, giảm kích thước trang web  

2.4. Thiết lập trang chủ cho FF:  

− Trang này sẽ được hiển thị đầu tiên khi mở IE, 

+ Thiết lập cho trang này bằng cách chọn Tools -> Options -> Main, 

+ Trong Startup nhập địa chỉ trang Web muốn làm trang chủ vào mục Home page. 

Có thể nhấn Use Current Page để chọn trang hiện đang xem làm trang chủ, 

+ Nhấn Restore to Default để chọn trang mặc định của FF hoặc nhấn Use 

Bookmark để chọn địa chỉ được lưu trong Bookmark.  

+ Sau khi chọn xong nhấn Ok. 
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Hình 2.7: Hộp thoại Options  

2.5. Xóa các dữ liệu và trang Web:  

− Để tránh người khác có thể biết được các trang Web đã được xem, chọn Tools -> 

Clear Recent History, trong Clear Recent History chọn các mục muốn xóa và nhấn 

Clear Now để xóa.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 2.8: Hộp thoại Clear Recent History 

2.6. Quản lý mật khẩu:  

− FF có chức năng quản lý mật khẩu để giúp người dùng tự động đăng nhập vào các trang 

Web có thiết lập mật khẩu.  

− Muốn xem và quản lý các mật khẩu này Chọn Tools -> Options -> Security, trong phần 

Passwords nhấn Saved Passwords 
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Hình 2.9: Hộp thoại Options 

3. Sao lưu nội dung trang Web:  

Khi đang xem một trang web, muốn lưu lại chọn File -> Save Page As... 

− Trong Save Page As, chọn nơi muốn lưu trang web trong Save in 

− Nhập tên trong ô File name, chọn Web Page, complete trong Save as type để lưu hết 

toàn bộ nội dung và Hình 1 ảnh của trang Web. Nhấn Save để lưu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 2.10: Hộp thoại save  

4. Xử lý một số sự cố thông dụng 

4.1. Tải các thành phần mở rộng:  

 Các thành phần mở rộng được cài thêm để hỗ trợ cho người dùng khi sử dụng FF 

để duyệt Web.  
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Hình 2.11: Hộp thoại Add-ons 

− Để tải các phần mở rộng này chọn Tools -> Add-ons -> Extensions, nhấn vào Get 

Extensions, nhấn Ok nếu xuất hiện một bảng cảnh báo an toàn. 

− Chọn thành phần mở rộng và nhấn Download để tải về, FF sẽ tự động cài đặt và sử 

dụng thành phần mở rộng này. 

4.2. Gỡ bỏ thành phần mở rộng  

− Chọn Tools -> Add-ons -> Extensions. 

− Chọn thành phần muốn gỡ và nhấn Uninstall hoặc có thể nhấn Disable để tạm ngừng 

hoạt động. 

4.3. Một số thao tác trên trình duyệt 

 

Hình 2.12: Cửa sổ trinh duyệt web 

a) Các thành phần trên cửa sổ trình duyệt  

− Giống như các cửa sổ khác, cửa sổ trình duyệt có thanh tiêu đề, thanh bảng chọn và 

thanh công cụ. Thanh tiêu đề bao gồm các nút Minimize, Maximize và close.  
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− Thanh công cụ chuẩn cho bạn hầu hết các lệnh và tuỳ chọn thường dùng trong chương 

trình. Thanh bảng chọn bao gồm các tuỳ chọn cho các chức năng của trình duyệt.  

b)  Di chuyển bằng thanh công cụ chuẩn và bàn phím  

− Thanh công cụ chuẩn cho ta các công cụ cần thiết để khám phá có hiệu quả web.  

 
+ Back: Quay lại trang trước 

+  Forward: Đảo ngược hành động của nút Back.  

+ Stop: huỷ bỏ việc tải trang web xuống.  

+ Refresh: Tải lại trang web bạn đang xem.  

+ Home: Quay về trang chủ. 

+  Search: Tìm kiếm theo chủ đề. 

+  Favorites: Chứa danh sách các website ưa thích.  

+ History: Hiển thị các site bạn đã viếng thăm.  

+ Full Screen: xem trang web trên toàn màn hình.  

+ Mail: Quản lí thư điện tử. 

+  Print: In trang web hiện tại.  

c) Thiết đặt trang chủ ngầm định:  

−  Với trang web bạn mở thường xuyên, hãy đặt trang đó là trang chủ. Cách làm như sau: 

Mở bảng chọn Tool/ chọn Internet Options  

 
Hình 2.13: Hộp thoại Internet Options 

− Gõ địa chỉ trang bạn chọn làm trang chủ vào hộp Address và nháy OK. 

4.3. Truy cập website 

a.  Mở một trang Web trên Internet: 

− Gõ trực tiếp địa chỉ của trang Web vào ô địa chỉ (address hoặc location tuỳ theo trình 

duyệt) hoặc dùng menu /File/Open 
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Hình 2.14: Hộp thoại Open 

b.  Định hướng trên Web 

+ Dùng các chức năng Back hoặc Forward để di chuyển giữa các trang Web 

+ Trở về trang HomePage.( được đặt trong phần Start Page). 

 

 Đến trang web “tìm kiếm” (Search) đặt sẵn trong trình duyệt 

c.  Điều khiển quá trình nạp (tải, download) tài liệu trên Web: 

+  Nạp lại trang web hiện đang được mở, Ngừng việc nạp (download) dữ liệu,  

d. Gọi chương trình gửi nhận e-mail từ Web Browser 

+  Gọi chương trình nhận, gửi e-mail của trình duyệt hoặc sử dụng menu: 

e. Lưu lại các địa chỉ Web ta thích, sử dụng tính năng Bookmark (Favorities): 

+ Đây là tiện ích của trình duyệt, cho phép người sử dụng lưu lại các địa chỉ các 

trang Web ưa thích một cách có hệ thống, theo chủ đề, theo tính chất sử dụng, theo sở 

thích cá nhân... 

f. Đặt Font chữ, cỡ chữ : 

+ Tool > Internet Options > phiếu General > Fonts>  

 
Hình 2.15: Hộp thoại Fonts 

− Chọn kích cỡ chữ : View > Text Size > chọn cỡ chữ 
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Câu hỏi ôn tập 

Câu 1: ISP là viết tắt của?  

A. Internet Service Provider 

B. Internet Server Provider  

C. Câu A,B đúng  

D. Câu A,B sai  

Câu 2: IAP là từ viết tắt của ?  

A. Internet Application Provider 

B. Internet Access Provider 

C. Câu A, B đúng  

D. Câu A, B sai  

Câu 3: Việt Nam chính thức gia nhập internet vào ngày tháng năm nào?  

A. 1/12/1997 

B. 12/08/1997 

C. 20/07/1997 

D. 30/07/1997 

Câu 4.  IRC là từ viết tắc của  

A. Internet Ready Chat 

B. Internet Realy Chat 

C. Câu A,B đều đúng  

D. Câu A,B đều sai  

Câu 5: modem kết nối internet có  

A. Thiết bị mạng  

B. Một loại máy in  

C. Một loại USB 

D. Một loại Volumn  

Câu 6: LAN SwiTch là gì?  

A. Là thiết bị mạng kết nối nhiều máy tính với nhau  

B. Là thiết bị mạng kết nối 2 máy tính với nhau  

C. Là thiết bị mạng kết nối internet 

D. Là thiết bị mạng có nhiều cổng kết nối các máy trạm trong một mạng Lan  
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BÀI 3: TÌM KIẾM THÔNG TIN TRÊN INTERNET 

Giới thiệu 

Internet là một kho tài nguyên thông tin vô tận được cung cấp bởi hàng triệu trang 

Web trên khắp thế giới. Các thông tin này rất đa dạng và có thể đúng, cũng có thể sai hoặc 

chưa đầy đủ, do đó người sử dụng cần phải tìm kiếm thông tin từ nhiều nguồn khác nhau 

và sau đó mới so sánh, tổng hợp để có được kết quả như mong muốn. Ngoài ra việc tìm 

kiếm được đúng thông tin cần thiết cũng không phải là chuyện dễ dàng. 

Mục tiêu của bài học 

− Trình bày được cách thức tìm kiếm thông tin trên internet  

− Xác định các nguyên tắc khi tìm kiếm và chọn lọc thông tin tìm kiếm được  

Nội dung bài  

1. Tìm kiếm căn bản 

− Tìm kiếm siêu dữ liệu (meta-search) là một hình thức tổ chức công cụ tìm kiếm, ở đó 

người dùng cũng có thể tìm thấy những thứ họ cần một cách chuyên nghiệp hơn. 

− Rất nhiều công ty kinh doanh tìm kiếm không thực hiện việc lưu trữ và lập chỉ mục các 

trang web trên internet, mà cung cấp một công cụ tìm kiếm siêu dữ liệu (meta-search 

engine). Các trang web thuộc loại này có thể kể đến Zing. Các trang này thường dùng dữ 

liệu từ các công cụ tìm kiếm khác, sau đó tổ chức lại bằng các câu lệnh AND OR hoặc 

những hàm toán học để đưa ra một kết quả chính xác hơn và tập trung vào một đối tượng 

cụ thể. 

 

 

 

 

 

 

 

 

 

 

Hình 3.3: Mô hình tìm kiếm siêu dữ liệu 

− Phương án này có lợi thế là triển khai ý tưởng nhanh mà không cần tốn tài nguyên lớn 

cho hệ thống lưu trữ và lập chỉ mục. Thay vào đó, các công cụ tìm kiếm này tập trung vào 

thuật toán xử lý kết quả, loại bỏ trùng lặp, hay phân tích ngữ nghĩa dựa trên mục tiêu mà 

trang web này hướng tới (hình bên cạnh biểu diễn rõ hơn mô hình này). Lấy ví dụ, một 

trang web về các quán ăn sẽ cho bạn biết “bún bò Huế” được bán ở đâu với giá bao nhiêu, 

dù chỉ sử dụng lại kết quả của Google; trong khi đó Google lại đưa ra đủ thứ gồm cả công 

thức nấu hay các bài báo nói về bún bò “sinh viên”,… 

− Tuy nhiên, tốc độ của tìm kiếm siêu dữ liệu thường chậm hơn, và một số trường hợp trả 

về kết quả chưa được tốt lắm so với những trang như Google, Live hay Yahoo. Vì thường 

các thuật toán trên cũng được các công cụ tìm kiếm truyền thống sử dụng rồi. Hơn nữa, 
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các máy chủ chỉ cung cấp một số lượng truy vấn giới hạn trong một ngày (Google: 1000 

truy vấn/ngày, Yahoo: 5000 truy vấn/ngày). 

− Một số công cụ tìm kiếm như Google cũng cung cấp một công cụ tương tự (Google gọi 

là Custom Search, và gần đây còn cung cấp thêm Search API và AppEngine). Công cụ này 

sẽ giúp cho các nhà quản trị web tạo công cụ tìm kiếm của họ dựa trên dữ liệu có sẵn của 

Google. Các nhà quản trị web này có thể cho phép người dùng tìm kiếm trên trang của 

mình, hoặc định hướng tìm kiếm đến một mục đích cụ thể,… Và hơn nữa, họ có thể kiếm 

được một khoản tiền nho nhỏ từ việc quảng cáo trên kết quả tìm kiếm từ trang của mình. 

2. Tìm kiếm thông tin với Google 

Môi trường Internet là một kho dữ liệu khổng lồ, nhưng cách tìm kiếm và khai thác ưu 

thế đó của Internet một cách hiệu quả thì không phải ai cũng hiểu hết.  

− Từ khóa (keyword) 

+ Nguyên tắc chung để tìm kiếm được thông tin chính xác là phải chọn được "từ khóa" 

(keyword) đúng. Nếu có được từ khóa đúng bạn sẽ tìm ra được trang web chứa 

thông tin cần tìm rất nhanh. Những ví dụ thông thường nhất như: Muốn tìm hiểu về 

thung lũng Silicon, nếu là tài liệu tiếng Việt thì bạn đánh chữ "thung lũng Silicon", 

tài liệu tiếng Anh thì bạn dùng từ khóa "Silicon Valley".  

+ Còn mẹo tìm kiếm khi bạn chưa biết chính xác từ khóa một cách trực tiếp như vậy 

thì có thể linh hoạt trong cách sử dụng từ khóa. 

o Ví dụ: Muốn tìm lời của một bài hát tiếng Việt hoặc tiếng nước ngoài mà bạn 

không biết tên bài hát là gì, do ca sĩ/ban nhạc nào hát (Cho nên bạn không 

thể đánh chính xác tên bài hát cũng như ca sĩ/ ban nhạc đó vào textbox tìm 

kiếm được).  

+ Cách giải quyết là bạn hãy cố gắng lắng nghe được một vài câu trong bài hát đó, 

hay một vài từ lặp đi lặp lại, dễ nghe nhất, rồi đánh vào textbox tìm kiếm, cho trong 

ngoặc kép những cụm từ bạn nghe được chính xác. Tôi muốn tìm đầy đủ lời bài 

"Vừa biết dấu yêu" của nhạc sĩ Quốc Bảo bằng cách đánh dòng "Tóc ai bay ngang 

lưng trời" vào textbox tìm kiếm. 

− Sử dụng dấu ngoặc kép (phrase) 

+ Dấu ngoặc kép được sử dụng thường xuyên trong việc tìm kiếm trên mạng khi bạn 

muốn kết quả đưa ra chính xác chứa cụm từ cần tìm, nếu cụm từ trong ngoặc kép 

càng nhiều thì phạm vi kết quả đưa về càng ít, bạn không phải "lọc" nhiều. Bạn có 

thể sử dụng nhiều cụm từ trong cùng một lần Search. Những cụm từ đó trong ngoặc 

kép và cách nhau bởi dấu trắng (dấu cách) hoặc dấu cộng (+) 
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Câu hỏi ôn tập 

TÌM LỜI BÀI HÁT TIẾNG ANH SANG - CA SĨ TRÌNH BÀY 

1. Lucky - Britney Spears  

2. Dancing Queen – Abba 

3. BestInMe 

4. Proud of you - Fiona Fung 

5. Jambalaya 

6. Lemon Tree  

7. Lucky - Lucky Twice 

8. Take Me To Your Heart - Michael Learns To Rock  

9. Nothing gonne change my love for you  

10. Yesterday  - The Beatles  

11. Fool again – Westlife 

12. Alittle Love 

13. All right - Blue  

14. Tell Laura I love her - Johnny T.Angel  

15. Love Story 

16. Earth Song - Michael Jackson  

17. MmMaMa 

18. Pretty boy 

19. The day you went away 

20. Woman-In-Love 

21. Barbie Girl – Aqua 

22. Only Yesterday  - Carpenters   

23. I Lay My Love On You  

24. Lala love ob My Mind 

25. Love To Be Love By Love 

26. Heal The World - Michael Jackson   

27. My heart will go on 

28. Soledad 

29. YesterdayOneMore 

30. I Swear 

31. Last Christmas 

32. That_s Why  - Michael Learn To Rock  

33. My Oh My 

34. You Belong With Me 

35. Say It Right 
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Bài 4: TẠO HỘP THƯ ĐIỆN TỬ- EMAIL 

Giới thiệu 

Thư điện tử (email hay e-mail) là một phương thức trao đổi tin nhắn giữa những 

người sử dụng các thiết bị điện tử. Thư điện tử lần đầu tiên được đưa vào sử dụng hạn chế 

trong thập niên 60 và đến giữa những năm 1970 có dạng như ngày nay gọi là email. 

Thư điện tử hoạt động qua các mạng máy tính mà hiện nay chủ yếu là Internet. Một 

số hệ thống thư điện tử ban đầu yêu cầu người gửi và nhận đều trực tuyến tại cùng thời 

điểm, giống với nhắn tin tức thời. Hệ thống thư điện tử ngày nay được dựa trên một mô 

hình lưu và chuyển tiếp. 

Mục tiêu của bài: 

− Thiết lập được trình quản lý email cho các hộp thư cá nhân 

− Sử dụng hộp thư thông qua trình quản lý như soạn thư, gửi thư, xóa thư, in thư 

Nội dung: 

1. Cài đặt chương trình gửi/nhận mail mail (Desktop mail 

Bước 1: Double click vào biểu tưởng   trên màn hình Desktop ( hoặc vào Start 

> All Program > Click Outlook Express  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 4.1: Hộp thoại Inbox O-E 

Cửa sổ phía trái của màn hình chứa các Folder (thư mục). Các Folder trong màn hình 

Outlook Express gồm:  

- Inbox (hộp thư đến): chứa những email của người khác gởi cho bạn.  

https://vi.wikipedia.org/wiki/Internet
https://vi.wikipedia.org/wiki/Nh%E1%BA%AFn_tin_t%E1%BB%A9c_th%E1%BB%9Di
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- Outbox (hộp thư đi): chứa những thư đã soạn xong nhưng chưa gởi đi.  

- Sent Items (những thư đã gởi đi): Mỗi lần bạn gởi email, Outlook Express sẽ chép 

một bản sao của thư đã gởi đi vào folder này.(Nếu không muốn lưu giữ bản sao của amail 

đã gởi đi, bạn mở menu Tool→chọn Option→chọn tab Sent→Chọn ô Save copy of sent 

messages in the “Send Items” Folder và xóa dấu check).  

- Deleted Items (các thư đã xóa): folder này có chức năng giống như Recycled Bin 

của Windows. Những thư bạn xóa sẽ được chuyển đến thư mục này. Bạn có thể xoá hẳn 

nó hoặc phục hồi lại bằng cách kéo và rê email muốn phục hồi đến thư mục cần chuyển 

tới.  

Draft (bản nháp): vì một lý do nào đó không thể hoàn tất một email, bạn có thể lưu 

email đang soạn dỡ dang vào thư mục này bằng cách chọn menu File Save. Khi bạn muốn 

soạn tiếp thì chỉ cần mở nó ra trong Drafts.  

Cửa sổ danh sách mail (phía bên tay phải) của màn hình Outlook Express hiển thị 

email của của thư mục hiện thời (là thư mục được bật sáng). Cửa sổ này cung cấp thông 

tin về người gởi (người nhận), tiêu đề, ngày giờ nhận của những email trong thư mục hiện 

thời. Cửa sổ phía dưới bên phải hiển thị nội dung của email hiện thời (là email được bật 

sáng). Khi bạn nhấp chuột vào email nào thì nội dung của email đó được hiển thị trên cửa 

sổ này. Nếu bạn muốn xem toàn màn hình nội dung  

Hình 4.2: Thanh công cụ Outlook Express 

 

Bước 2: Mở tài khoản e-mail 

a. Click Tools → Accounts mở hộp thoại Internet Accounts  
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Hình 4.3: Cửa sổ Outlook Express 

b. Nhấp nút Add, chọn Mail.  ➔ Internet Connection Wizard hiện ra  

 
 

Hình 4.4: Cửa sổ Internet Account 

 

c. Gõ tên hiển thị của bạn vào ô Display name.  

+ Đây là tên sẽ hiển thị ở cột From ở màn hinh Inbox của người nhận lúc bạn gởi thư 

đi; không nhất thiết trùng User name, mà có thể là bí danh, tên họ đầy đủ, hoặc tên viết 

tắt ➔ Nhấn Next 
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Hình 4.5: Hộp thoại Internet Connection Wizard 

d. Gõ địa chỉ e-mail của bạn vào ô E-mail address ➔ Next  

 
Hình 4.6: Hộp thoại Internet Connection Wizard 

e. Màn hình E-mail Server Names đòi hỏi những thông tin mà bạn lay từ ISP của mình  

+ Một cửa sổ mới xuất hiện yêu cầu nhập địa chỉ email. Bạn nhập địa chỉ email mà 

công ty Internet đã cung cấp cho bạn trong box Email-mail address rồi nhắp Next để tiếp 

tục: 
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Hình 4.7: Hộp thoại Internet Connection Wizard 

 

+ Bây giờ bạn hãy nhập tên của máy tính chủ email mà ISP đã cung cấp cho bạn. Box 

Incoming mail (POP3, IMAP or HTTP) server để nhập tên máy chủ nhận email và còn lại 

để nhập tên máy chủ gửi email (ví dụ Incoming mail server và Outgoing mail server của 

mạng FPT là pop.mail.yahoo.com.vn và smtp.mail.yahoo.com.vn). Tiếp đó nhắp nút 

Next: 

+ Một cửa sổ mới xuất hiện yêu cầu nhập địa chỉ email. Bạn nhập địa chỉ email mà công 

ty Internet đã cung cấp cho bạn trong box Email-mail address rồi nhắp Next để tiếp tục:  

 
Hình 4.8: Hộp thoại Internet Connection Wizard 

+ Bây giờ bạn nhập username mà bạn đăng ký với ISP vào box Account name (ví dụ nếu 

email của bạn là sethion@yahoo.com.vn thì bạn account name của bạn là sethion). Nếu 

bạn muốn Outlook Express nhớ password và tự sử dụng khi vào mạng thì hãy nhập 

password rồi đánh dấu vào lựa chọn Remember password. Tiếp tục nhắp nút Next: 



31 
 

 
Hình 4.9:Hộp thoại Internet Connection Wizard 

+ Đến đây bạn chỉ cần nhắp nút Finish để hoàn thành cài đặt email vào Outlook Express. 

2. Cấu hình gửi/nhận mail với MS Outlook 

2.1. Cách khai báo trong Outlook Express cho các dịch vu Webmail như sau: 

2.1.1. Gmail 

− Khai báo Incoming mail (POP3) là pop.gmail.com. 

− Khai báo Outgoing mail (SMTP) la smtp.gmail.com. 

− Trong phần Incoming Server, nhập đầy đủ địa chỉ e-mail và password. 

− Trong phần Outgoing Server, đánh dấu chọn mục My server (SMTP) requires 

authentication > chọn Log on using rồi nhập đầy đủ địa chỉ e-mail và password. 

− Khai báo Server Port Numbers cho Outgoing mail (SMTP) là 465, cho Incoming 

mail (POP3) là 995. Đồng thời đánh dấu chọn cả hai mục server requires an 

encripted connection (SSL). 

− http://www.mediazone.vn/home/images/stories/ttmt/2009/58/lehoan2.jpg 

2.1.2. Ymail 

− Khai báo Incoming mail (POP3) la pop.mail.yahoo.com.vn (nếu khai báo nơi cư trú 

là Việt Nam) và Port la 995. 

− Khai báo Outgoing mail (SMTP) la smtp.mail.yahoo.com.vn va Port la 465. 

− Các phần còn lại khai báo tương tự như Gmail. 

2.1.3. Yahoo! 

− Khai báo Incoming mail (POP3) là pop.mail.yahoo.com và Port là 110. 

− Khai báo Outgoing mail (SMTP) la smtp.mail.yahoo.com va Port la 25. 

− Trong phần Incoming Server, chỉ nhập phần trước dấu @ trong địa chỉ e-mail và 

password. 

− Trong phần Outgoing Server, chỉ cần đánh dấu chọn mục My server (SMTP) 

requires authentication. 

− Chú ý: Bạn phải cho hiệu lực chức năng hỗ trợ POP3 trong phần Settings của các 

dịch vụ Webmail đang sử dụng. 

3. Thiết lập môi trường làm việc cho MS Outlook  

− Cấu trúc một lá thư 

− Một email bao gồm : 
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Hình 4.10: Cửa sổ Outlook Express 

− Người gởi (From): người gửi là một địa chỉ email (ví dụ public@yahoo.com.vn) và 

thường được Outlook Express gán theo tên đã cài đặt vào Outlook Express trước 

khi gửi đi.  

−  Người nhận (To): cũng là một địa chỉ email và thường được máy chủ mail người 

nhận gán tên.  

−  Ngày giờ nhận(Date): là giờ mà email đó đến được máy chủ của người nhận.  

−  Tiêu đề thư (Subject): tiêu đề email do người gởi đặt.  

−  Nội dung email.  

−  File gửi kèm (Attach): một email có thể có hoặc không có file gửi kèm, là một hoặc 

nhiều file được người gửi đính kèm với email.  

−  Chữ ký (Signature): là một phần trong nội dung email được người gởi tạo ra trước 

và lưu vào Outlook Express. Mỗi lần gửi mail Outlook Express sẽ tự lấy phần chữ 

ký này để gán vào phần cuối nội dung của mỗi bức thư. Chữ ký có thể là một phần 

văn bản hoặc một hình ảnh và việc tạo chữ ký là không bắt buộc.  

3.1. Soạn thảo và gửi một bức thư  

− Bạn hãy khởi động Outlook Express bằng cách nhắp đúp chuột vào biểu tượng 

Outlook Express trên màn hình (hoặc vào nút Start → Programs →Outlook 

Express), sau đó nhắp nút Create Mail, cửa sổ email sẽ xuất hiện  
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Hình 4.11: Cửa sổ mail Outlook Express 

− To:  gõ địa chỉ email của người nhận.  

− Cc:  để nhập địa chỉ email của người đồng nhận email này (một email có thể gửi 

cho nhiều người), gởi cho nhiều người thì cách các địa chỉ bằng dấu ‘phẩy’.  

− Subjec: để nhập tiêu đề email.  

− Tiếp đó, bạn gõ nội dung mail trong vùng trống để soạn thảo email.  

Một số chức năng trên thanh định dạng: 

 
Hình 4.12: Thanh công cụ định dạng Outlook Express 
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Hình 4.13: Hộp thoại đính kèm file 

− Chọn file gửi kèm rồi nhắp nút Attach 

− Sau khi hoàn tất gửi email, bấm vào nút  trên cửa sổ soạn thư. Email của 

bạn sẽ được lưu vào folder Outbox. Bạn có thể soạn nhiều thư trước khi gửi tất cả 

đi.  

− Để gửi đi, bạn chỉ cần nhắp chuột vào nút Send/Recv  trên Tool bar của 

màn hình Outlook Express. Nếu bạn chưa kết nối vào mạng, cửa sổ kết nối tự động 

hiện ra yêu cầu bạn vào mạng. 

3.2. Nhận, đọc trả lời một bức thư  

− Để nhận email, bạn chỉ cần nhấp chuột vào nút Inbox, Outlook Express sẽ gởi tất cả 

email có trong OutBox.  

 
Hình 4.14: Hộp thoại Outlook Express 

− Tiếp đó, Outlook Express kiểm tra Mail Server, nếu có email nó sẽ lấy về mày tính 

và lưu ở Inbox. Nếu muốn ngừng kết nối vào mạng ngay sau khi Outlook Express 

nhận và gửi email, hãy đánh dấu vào lựa chọn Hang up when finished. Hủy bỏ lựa 

chọn nếu vẫn muốn tiếp tục trên mạng sau khi đã gởi và nhận email. 
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Hình 4.15: Hộp thoại Outlook Express 

− Bạn có thể ngừng nhận/gửi email bằng cách nhấp vào nút Stop khi Outlook Express 

đang nhận/gửi email 

4. Thực hiện lưu trữ trong Outlook 

4.1. Chuyển tiếp, vào xóa một bức thư 

− Khi nhận được thư mới, Outlook Express đặt chúng vào thư mục Inbox- trừ khi bạn 

quy định khác đi 

4.2. Inbox – hộp thư đến 

− Khi nhận được thư mới, Outlook Express đặt chúng vào thư mục Inbox trừ khi bạn 

quy định khác đi 

 
Hình 4.16: Hộp thoại Inbox - Outlook Express 

4.3. Outbox – hộp thư đi 

− Nếu bạn soạn thư ở chế độ ngoại tuyến (Work Offine) và nhấp vào nút Send, thư sẽ 

được vào Outbox,  nằm chờ đấy đến khi nào bạn kết nối vào Internet và nhấp 

Send/Recv sẽ truyền đi ngay. Thư đã truyền đi được dời từ Outbox sang thư mục 

Sent Items. (Lưu ý là các dịch vụ e-mail trực tuyến như Yahoo!, Hotmail, … không 

có thư mục Outbox vì không hỗ trợ chế độ làm việc ngoại tuyến.) 

4.4. Sent Items – Thư đã gởi đi 
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− Truyền thư đi xong, Outlook Express chuyển chúng đến thư mục Sent Items. Nếu 

không thích giữ lại bản sao thư từ đã gởi đi, hãy xoá tuỳ chọn Send copy of sent 

message in the “Sent Items” folder trên trang Send của hộp thoại Tools > Options 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 4.16: Hộp thoại Optiions 

 

4.5. Deletem Item – thư đã bị huỷ 

− Những thư bị delete, dù ở thư mục mail nào, cũng đều chưa bị xoá sổ hẳn, mà sẽ 

dồn vào thư mục Deleted Items – vùng lưu trữ cuối cùng. Với thư từ trong mục 

Deleted Items, bạn vẫn có thể hồi đáp, chuyển tiếp, hoặc hiệu chỉnh chúng. Còn như 

quyết định detele như trong thư mục này chúng sẽ vĩnh viễn đi luôn không trở lại 

− Cách hồi phục những thư từ còn lưu  trong Sent Items: kéo thư từ thư mục này đến 

tên thư mục đích trong cây thư mục Floder ); hoặc chọn thư và nhấp lệnh Edit > 

Move To Folder. Định rõ tên thư mục đích 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 4.17: Cửa sổ phục hồi thư mục đã xóa 
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4.6. In một bức thư 

− Mở một bức thư muốn in và nhấn vào nút Print 

5. Cấu hình và quả lý webmail 

Chúng ta có một tên miền và muốn tạo mail theo tên miền đó. Sau đây chúng ta sẽ 

cấu hình để có thể tạo được mail theo tên miền đó. 

Giả sử ta có một tên miền (VD: trungcapnghecuchi.edu.vn) và ta muốn tạo cấu hình 

để tạo mail theo tên miền của bạn (VD: leduycuong@)trungcapnghecuchi.edu.vn - cái này 

được gọi là webmail. Sau đây tai sẽ  cấu hình để tạo webmail. 

Các bước chính để tạo webmail: 

Bước 1: vào https://www.google.com/a/cpanel/domain/new?hl=vi để đăng ký dịch vụ 

Google Apps của Google. 

 

 

Hình 4.18: Cửa sồ đăng ký Google Apps 

Bước 2: Xác minh quyền sở hữu tên miền 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 4.19: Cửa sổ xác định tên miền 
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Bước 3: Cài đặt Email và thay đổi bản ghi MX 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 4.20: Hộp thoại cài đặt mail 

 

Bài Tập Thực Hành 

Bài 1: TẠO BLOG TRÊN YAHOO 

Bước 1: Mở Internet Explorer 

Bước 2: Vào google hoặc yahoo 

Bước 3: Gõ vào google hoặc yahoo yahoo plus 

Bước 4: Click vào Yahoo ! 360 plus 

 
Bước 5: Đăng nhập
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Bước 6: Tạo blog 

 
Bước 7: Gõ tên Nickname 

Bước 8: Nhập tên blog 

Bước 9: Chọn URL mặc đinh http://vn.360plus.yahoo.com/kimloancuchi 

 
Bước 10: Click vào Blog của tôi 
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Bài 2: Gởi SMS Trên Yahoo Mail 

Bước 1: Đăng nhập vào Yahoo 

Bước 2: Click chọn tam giác ngược của Soạn thư  sau đó chọn Tin nhắn (SMS) 

 
Bước 3: Nhập số điện thoại cần chat 

 
Bước 4: Nếu số điện thoại đó chưa có trong danh sach liên lạc của bạn. Click Thêm địa 

chỉ 

 
Bước 4: Nhập các thông tin liên quan đến số điện thoại đó 
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Bước 5: Nhấn Lưu 

 
Bước 6: Click OK 

 

  



42 
 

Bài 5:  CÀI ĐẶT CHƯƠNG TRÌNH HỘI THOẠI INTERNET 

Giới thiệu 

Nói chuyện trực tiếp trong khoản thời gian thực. 

Thảo luận các vấn đề mà không phải đợi trả lời như sử dụng mail. 

Trao đổi thông tin một cách nhanh chóng bằng âm thanh, hình ảnh, hoặc dạng text. 

Tổ chức các cuộc hội thoại với nhiều thành viên.  

Có 2 hình thức hội thoại phổ biến là Chat Text và Chat Voice. 

Có 2 kiểu hội thoại là Web Chat và Instat Messaging(IM) Cha 

Mục tiêu của bài: 

− Hiểu mô hình hoạt động của dịch vụ hội thoại 

− Cài đặt, cấu hình và nâng cấp các trình hội thoại thông dụng 

Sử dụng thành thạo các tính năng của các chương trình hội thoại YM, Skype, Paltalk,... 

Nội dung: 

1. Cài đặt các chương trình hội thoại 

 

2. Thiết lập và sử dụng hội thoại với YM, Skype, Paltalk 

 

3. Xử lý sự cố thông dụng 
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